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1. Uvod

SRS GRASS GIS je program koji je originalno razvijan od strane

Bringing advanced geospatial technologies to the w

Istrazivackih laboratorija za gradevinski inZenjering vojske
Sjedinjenih  Ameri¢kih Drzava (U.S. Army Construction
Engineering Research Laboratories). GRASS (Geographic
Resource Analysis Support System - Sistem za podrSku analizi geografskih resursa) postao je
najkorisc¢eniji GIS softverski paket otvorenog koda. Ovaj program sadrzi moguénost GIS analize,
kao 1 moguénost obrade podataka dobijenih daljinskom detekcijom. GRASS je proizvod sa
brojnim verzijama. Koristi rasterske i vektorske podatke [1].

GRASS GIS 1ili samo GRASS je besplatan GIS softverski paket otvorenog izvornog koda
(Open Source) koji se koristi za upravljanje 1 analizu geoprostornih podataka, obradu slike,
proizvodenju karata, prostorno modelovanje i vizualizaciju. GRASS GIS se danas koristi u
akademske i1 komercijalne svrhe Sirom svijeta, koriste ga mnoge drzavne agencije kao i
kompanije za zaStitu zivotne sredine [3]. Postoje brojne definicije GIS-a. Jednu od najcesce
koriS¢enih dala je firma ESRI: Geographic Information System (GIS) integriSe hardver, softver 1
podatke za snimanje, upravljanje, analiziranje i prikaz svih oblika geografskih informacija od
vaznosti. GIS omoguéava da vidimo, tumacimo, razumijemo i vizualizujemo podatke sa
prostornim geografskim karakteristikama, da utvrdimo obrasce, Seme, zavisnost i trendove

posmatraju¢i mape, globuse, grafikone [2].



2. GRASS GIS kao Open Source

Sama ideja Open Source softvera postoji od nastanka i samog softvera. Rezultati
istrazivanja 1 razvoja na univerzitetima i drzavnim laboratorijama su ¢esto dostupni u obliku
javnog domena. Richard M. Stallman je prvi definisao koncept besplatnog softvera kroz sljedeca
Cetriri stepena slobode:

0. freedom : Stepen slobode da se program koristi za bilo koju namjenu.

1. freedom : Stepen slobode za izucavanje rada programa i adaptacije svojim potrebama.

2. freedom : Stepen slobode koji omogucava redistribuciju kopija.

3. freedom : Stepen slobode koji potpomaze program u cilju §irenja verzije tako da Sira

javnost ima korist.

Softver koji prati ova Cetiri principa je nazvan “’Free Software *°. 1984. godine Stallman je
poceo sa radom na GNU projektu 1 ve¢ 1985. godine kreirao je ©* Free Software Foundation’” za
podrsku konceptu besplatnog softvera. Licenca GNU projekta, GNU General Public Licence
(GPL) ne garantuje samo cCeiti prethodno opisana stepena slobode nego ih i Stiti. Korisnik
softvera je takode zaSti¢en sve dok su stepeni slobode garantovani. Upravo ovim je GPL postala
najcesce koriS¢ena licenca za Free Software [1].

Tokom nekoliko zadnjih godina sve vise raste broj Open Source GIS rjesenja.

GRASS GIS sadrzi 350 modula za renderovanje mapa i slika na moniotru i papiru; manipulaciju
rastera i vektor podataka koji uklju¢uju vektorske mreze; procesiranje multispektralnih podataka;
1 kreiranje, upravljanje i ¢uvanje prostornih podataka. GRASS GIS nudi graficki interfejs kao 1

komandnu liniju [9].

2.1 Istorija GRASS GIS-a

Kao $§to je ve¢ receno u uvodu, GRASS je razvijan u periodu od 1982. do 1995. godine od

strane americke vojske. Prva ideja koju su htjeli razviti je pouzdan softverski alat za potrebe



upravljanja zemljiStem u vojne svrhe. U drugoj polovini osamdesetih godina objavljen je
GRASS sa potpunim izvornim kodom za internet. Razvoj interneta u ovom periodu je doveo do
razvoja softvera na svjetskom nivou.

Godine 1995. Susan Huse, sa Kalifornijskog univerziteta u Berkliju, razvila je
GRASSLinks, kao dio doktorske disertacije. GRASS je do tada bio desktop GIS alat, njegove
funkcije nisu bile dostupne na Web-u. Ona je implementirala interfejs izmedu Web servera 1
GRASS-a koji je omogucio korisnicima da selektuju slojeve podataka putem Web c¢itaca i Salju
zahtjeve Web serveru. Server je te zahtjeve proslijedivao GRASS-u na analizu (kao §to je buffer
analiza, preklapanje lejera, reklasifikacija, kartiranje 1 drugo). Obradeni rezultati su vracani
korisnicima putem Web citaca. GRASSLinks je bio rani primjer koji je demonstrirao da Web
GIS moze i¢i dalje od jednostavnog kartiranja i upita ka sofisticiranim analizama [1]. Dvije
godine nakon toga se pojavljuje nova verzija, GRASS 4.2 koja je publikovana od strane Baylor
University. Verzija GRASS 4.2.1 je predstavljena 1998. godine i kodirana je od strane dva
profesora, Marcus Neteler i Helena Mitasova sa univerziteta u Hanoveru.. Ovom verzijom su
otklonjeni svi nedostaci u softveru, te je dodato jo§ 50 novih modula. U periodu od 2001. do
2007. godine verzije su kreirane od strane ITC-irst (Centro per la Ricerca Scientifica e

Technologica), Trento, Italy.

2.2 GIS koncept, geoprostorni modeli podataka

Podaci u GIS bazi podataka obezbjeduje jednostavnu, digitalnu reprezentaciju objekata na
Zemlji za odredeno podrucje. Georeferencirani podaci mogu biti organizovani koriS¢enjem
razli¢itih kriterijuma, npr. kao tematski lejeri ili prostorni objekti. Svaki tematski lejer moze biti
sacuvan koriS¢enjem adekvatnog modela podataka zavisno od izvora podataka i njihove
potencijalne upotrebe.

Georeferencirani podaci ukljucuju prostorne (geometrijske i geofizicke) komponente koje
opisuju lokaciju ili prostornu raspodjelu geografskih fenomena i atributa koji se koriste za
opisivanje njihovih karakteristika. Prostorne komponente mogu biti predstavljene koris¢enjem
jedne od dvije osnovne varijante:

e prostorna reprezentacija gdje svaka regularno rasporedena tacka ili piksel ima
adekvatnu vrijednost pa jasno zakljuCujemo da se radi o rasterskom modelu
podataka,

e geometrijska reprezentacija objekata gdje su objekti definisani kroz linije, tacke ili

poligon i njihove koordinate $to jasno ukazuje na vektorski model podataka.
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Slika 1- Modeli podataka — raster i vektor sa tabelama atributa

Od razmjere zavisi nacin reprezentacije geografskih objekata.

2.2.1 Rasterski model podataka

Raster je regularna matrica vrijednosti sa redovima i kolonama. Presjek reda i kolone
predstavlja najmanji element matrice. Za 2D matrice to je piksel, a za 3D matrice najmanji
element se naziva voksel. Ako su vrijednosti predstavljene u grid tackama raster zapravo
predstavlja kontinualno polje (elevacija, temperatura, hemijska koncentracija). Ako je pak
vrijednost smjeStena u c¢elijama grida (pikseli, povrSinske jedinice) tada je predstavljena slika
(satelitski snimak, skenirana mapa, konvertovana vektorska podloga). Rasterski model podataka
je najcesce koriscen za fizicke i bioloske podsisteme geosfere kao $to su elevacija, temperatura,
vegetacija. Takode moze biti koriS¢en da podatke predstavljene linijama i poligonima kao $to su
putevi i karakteristike zemljiSta, narocito kod skeniranih mapa. rasterski model podataka je
kreiran sa fokusom na analizu, modeliranje i1 procesiranje slika. Njegova osnovna prednost je

jednostavnost [4].

2.2.2 Vektorski model podataka

Vektorski model podataka se koristi za predstavljanje tacaka, linija i poligona. Osnovni
element ovog modela podataka je tacka. Svaka tacka je definisana svojim koordinatama. S
obzirom da nema dimenziju, tacka predstavlja nula-dimenzionalnu geometrijsku primitivu i sa
njom su prikazani entiteti jako malih dimenzija koji se ne mogu prikazati u razmjeri pomoc¢u
linija 1 poligona. Skup takvih tacaka <¢ini jedan linijski element. Linija je sada
jednodimenzionalna primitiva. Povezivanjem viSe linija dobijamo neku oblast koju nazivamo

poligon. Mozemo lako zakljuciti da je sada to dvodimenzionalni element [4].

point line area zurface volume

Slika 2 — Dimenzije podataka u GIS-u



2.3 Atributi- GIS i baze podataka

Atributi predstavljaju deskriptivni dio nekog entiteta. Baza podataka koristi odgovarajuce
koordinate 1ili identifikacione brojeve da poveze atribute sa geometrijskim podacima. Za
rasterske podatke, GRASS podrZava samo jedan atribut za svaku Celiju kategorije. Za vektorske
podatke, GRASS nudi genericki SQL-DBMS apstaktni lejer sa dvije mogucnosti izbora
(limitovani DBF fajl ¢ita¢ i SQLite drajver) i nekoliko interfejsa za ekternu bazu podataka (

PostgreSQL, MySQL i sli¢no) [4].

2.4 Transformacija modela podataka

Isti fenomen ili objekat moZe biti predstavljen razli¢itim modelom podataka. GIS obi¢no
ukljucuje alate za transformaciju izmedu vektorskog i rasterskog modela podataka. Npr. visina
moze biti mjerena kao vektor odnosno kao tacka, zatim interpolirana na rasterskoj mapi $to se
dalje moze koristiti za dobijanje konturnih linija. Transformacija izmedu razli¢itth modela

podataka je najceS¢e bez gubitka podataka [4]

2.5 Baza podataka i komandna struktura

GRASS podaci su smjesteni u direktorijumu koji se odnosi na GISDBASE. Direktorijum,
obi¢no nazvan grassdata, mora biti kreiran prije pocCetka rada sa GRASS-om. Moze se kreirati
koriS¢enjem mkdir komande ili fajl menadZera. Unutar direktorijuma, GRASS GIS podaci su bili

organizovani po projektima sacuvanim u poddirektorijumima nazvanim LOCATIONSs (Slika3).
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Slika 3- Organizacija GRASS direktorijuma podataka, LOCATION, MAPSET, raster mape i

vektori

Svaka lokacija je definisana svojim koordinatnim sistemom, projekcijom mape i
geografskim granicama. Poddirektorijum 1 fajlovi koji definiSu LOCATION su kreirani
automatski kada je GRASS pokrenut prvi put. Svaka LOCATION moze imati nekoliko
MAPSET-ova koji se koriste za podjelu projekta na razli¢ite teme, podregione. Svaki korisnik
moze ucitavati mape u razli¢itim MAPSET-ovima ali moze vrsiti modifikaciju ili brisati samo u
njegovom MAPSET-u. Svi MAPSET-ovi uklju¢uju WIND fajl koji sadrZi trenutne granice
koordinatne vrijednosti i trenutno selektovanu rezoluciju rastera. Kada kreiramo novu
LOCATION, GRASS automatski kreira specijalni MAPSET pod nazivom PERMANENT.
Dizajniran je da cuva glavne podatke projekta. Samo vlasnik PERMANENT MAPSET —a moze
dodavati, modifikovati ili brisati njegove podatke, dok podaci mogu biti analizirani i kopirani od
strane drugog korisnika za njegov MAPSET.

GRASS moduli su organizovani po imenima, zasnovani na njihovoj funkciji klase, Prvo
slovo se odnosi na funkciju klase pracenu tackom i jednu ii dvije druge rijeci, takode odvojene
tatkama koje opisuju specifi¢ni zadatak koji vrS$i modul. Na slici ispod je prikazana lista bitnih

funkecija klasa.

prefir function class type of command

.= display graphical output

db.# database database management

g. zeneral general file operations

1% hmagery image processing

n.* nisc izcellaneons comimands

n mise mizcellaneons commands

s postscript map creation in Postseript format
I raster 2D raster data processing

ra. 3D raster 3D raster data processing

V. vector 2D and 3D vector data processing

Slika 4- Spisak GRASS modul funkcija klasa



Generalna sintaksa GRASS komande :

modul [-flagl[flag2...]] parametarl=mapal[,mapa2,...|\
[parametar2=broj...] [--0] [--q] [--V]

e Modul; oznacava ime komande tj. funkcije.
e Flag; opciono, predstavlja specijalne karakteristike, poziva se odredenim slovom.

e Parameter; predstavlja ime za ulazni ili izlazni fajl, konstantu, ime metode, simbol.

Vazno je znati da izmedu kljucnih rijeci koje su razdvojene tatkom ne smije biti razmaka kao ni
prije 1 poslije znaka jednakosti. Sa druge strane, izmedu parametara i flags se nalazi razmak dok
je viSe parametara pri nabrajanju razdvojeno zarezom. Takode, prvi parametar koji se navodi ne
zahtijeva ispis kljucne rijeci parameter. Sa nekoliko sljede¢ih primjera bice ilustrovano
koriS¢enje gore navedenih pravila. Recimo, v.in.shape predstavlja vektorsku komandu za
ucitavanje ESRI SHAPE fajla, r.buffer racuna bafer zonu raster linije i raster zone, g.list rast ¢e

ispisati listu raspolozivih rastera unutar MAPSET itd.



3. Procesiranje i analiza slika

Daljinska detekcija, kako sve vise napreduje kao tehnologija za prikupljanje podataka o
okruzenju koriste¢i Sirok spektar satelita i vazduhoplovnih platformi danas igra glavnu ulogu u
prostorno-vremenskom monitoringu zemljine povr§ine. GRASS obezbjeduje nekoliko modula za
obradu slike. Podaci se obraduju koris¢enjem modula za raster, prema tome mogu se primijeniti
svi rasterski moduli. Prepoznatljivi su po prefiksu "i.".

Uopsteno receno, digitalna slika je niz brojeva koji prikazuju prostornu raspodjelu
odredenih karakteristika terena (refleksija elektromagnetnog zracenja, temperatura, geofizicke
karakteristike). Digitalna slika se sastoji od diskretnih elemanata slike koji se zovu pikseli. Za
svaki piksel je vezan digitalni broj- DN odnosno diskretna vrijednost piksela kojom se definise
njegov spektralni intenzitet 1 izraZava se vrijednoS¢u od 0 do n (255). Veli¢ina piksela ima uticaj
na koli¢inu detalja prikazanu na sceni. Sto je veli¢ina piksela manja, to je vise detalja vidljivo.
Digitalnu sliku definiSemo kao odmjerenu, kvantovanu funkciju dvije varijable koja je
generisana optickim sredstvima, odmjerena u jednako razmaknutim tackama i kvantovana
jednakim intervalima amplitude.

Procesiranje 1 analiza slike se definiSe kao proces analiziranja slike za potrebe
identifikovanja objekata i procjenu njihovog znacaja. Vr$i se analiza daljinski detektovanih

podataka kroz logicke procese:

detekcije,

identifikacije,

klasifikacije,

mjerenja i procjene znacaja objekata se utvrduju njihovi prostorni odnosi.



4. Klasifikacija

Jedan od glavnih ciljeva daljinske detekcije je dobijanje tematskih karata koje opisuju
trenutnu upotrebu/pokrivenost zemljista. Sto se tide GIS konteksta, ove mape se &esto koriste da
dopune podacima mape dobijene konvencionalnim tehnikama. Rezultati klasifikacije prikazuju
dominantnu upotrebu zemljista na odredenom podrucju. Razvijene su brojne metode
klasifikacije; GRASS pruZza moguénost rada sa setom standardnih metoda , ali se 1 dodatni
modovi mogu implementirati u "C" 1 mnogim drugim programskim jezicima, zahvaljuju¢i Open
Source rjesenjima.

U osnovi, dvije strategije su glavne za klasifikaciju snimaka daljinske detekcije- supervised
1 unsupervised. Supervised ili klasifikacija sa nadzorom zahtijeva interakciju korisnika. Naime
potrebno je da definiSe po jednom svako karakteristicno podrucje kako bi kasnije algoritam
odradio posao za cijeli snimak.

Obicno klasifikacija koristi metod (MLC - Maximum Likelihood Classifier) zasnovan na
pikselima. GRASS opet koristi i drugaciji metod (SMAP- Sequential Maximum A Posteriori
classifier) koji posvecuje paznju i susjednim pikselima za supervised klasifikaciju.. Cetiri
razli¢ite metode za analizu satelitskih snimaka zajedno sa dvije glavne metode su:

e Radiometrijska klasifikacija:
- unsupervised klasifikacija (i.cluster, i. maxlik koristi MLC metod)
- supervised kalsifikacija i

- djelimic¢na supervised klasifikacija (i.class, i.gensig, i.maxlik)
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podataka

e Kombinovana radiometrijska/geometrijska supervised klasifikacija (i.gensiget,

i.smap koristi SMAP metod) [4]
Ono $to predstavlja glavni problem u daljinskoj detekceiji jesu “’mijeSani’’ pikseli koji prekrivaju
razli¢ite objekte. U ovom slufaju prethodno spomenuti metodi stavljaju taj piksel u

najdominantniju klasu sa najmanjim nivoom povjerenja.

4.1 Unsupervised klasifikacija

Unsupervised klasifikacija automatski vrs$i raspodjelu piksela na rasteru u razlicite
spektralne klase. Raspodjela je bazirana na statistici slike. Ova klasifikacija ima dva glavna
koraka. Prvi korak, algoritam klasifikacije grupiSe piksele sa slicnim statistiCkim
karakteristikama ispunjavaju¢i minimalnu veli¢inu klastera/klase, separabilnost klase, procentna
konvergencija, maksimalni broj iteracija,semplovanje intervala i taj korak se naziva klastering
podataka.

e Minimalna veli¢ina klase: minimalni broj piksela za definisanje klastera;

e Separabilnost klase: minimalna razdvojenost izmedu dva klastera. Zavisi od toga
da li je slika reklasifikovana i da li je broj finalnih klastera statisticki prihvatljiv.
Vrijednosti se kre¢u najcescée izmedu 0.51 1.5;

e Procentna konvergencija;



e Maksimalni broj iteracija: definiSe maksimalni broj iteracija koji je veci od broja
iteracija predvidenih da se postigne optimalna procentna konvergencija Hi-kvadrat
testa; korisnik moze ponovo pokrenuti i.cluster sa ve¢im brojem iteracija;

e Semplovanje intervala: pojednostavljuje proracune grupisanjem piksela u blokove.
Ukoliko ¢e resursi sistema biti uskoro iscrpljeni zbog male veli¢ine bloka i.cluster
¢e upozoriti samog korisnika. Sa adekvatnim hardverom, nepreporucljivi sempling
moze postati nepotreban.

Drugi korak se naziva unsupervised klasifikacija podataka. Ovakva klasifikacija zasnovana na
MLC algoritmu moze biti izvrSena sa i.maxlik. Modul dodjeljuje sve piksele iz satelitskog
snimka u spektralne klase izvedene iz prethodnih klasterskih procesa. Potrebno je dati naziv
reklasifikovanom snimku i naziv za odbacenu treshold mapu.

Klasteri piksela su kategorije na slici koje mogu biti povezane sa vrstama koje pokrivaju
zemljiSte. Iterativni algoritam racuna srednju vrijednost klastera i kovarijacionu matricu ( modul
i.cluster). Osnovna ideja je da se identifikuju oblaci piksela koji imaju sli¢nu vrijednost
reflektivnosti u razli¢itim kanalima. Svaki oblak piksela se grupiSe u klastere koji reprezentuju
upotrebu zemljista. MLC metod ¢uva podatke od nivou povjerenja za svaki pixel koji pripada
odgovarajucoj klasi. Ova mapa je nazvana "reject treshold map layer". Visoka vrijednost u
rejection mapi ukazuje da je malo povjerenje da pixel pripada bas toj klasi. Jedan od vidova
upotrebe ove mape je MASK 1 sluZi za identifikovanje Celija u reklasifikovanoj slici koji imaju
najmanju vjerovatnocu da su u korektnoj klasi. Vazno je napomenuti da MLC metod koristi

normalnu raspodjelu [4].

4.2 Supervised radiometrijska klasifikacija

U supervised klasifikaciji, klasifikacioni proces je podrzan od stane interaktivne selekcije
poznatih podru¢ja. Osnovna ideja je selektovanje poznatih podru¢ja i cuvanje njihovih
spektralnih potpisa. Ova podrucja su poznata kao "ground truth" podrucja. Vazno je napomenuti
da su poznata podrucja homogena. Ukoliko poznato podrucje pokriva vise piksela, male lokalne
varijacije su ukljucene u definicju klase. Za verifikaciju, modul i.class podrzva analizu "chanel-
wise" histograma. Histogram sadrzi standardnu devijaciju i Gausovu raspodjelu. Ova standardna
devijacija moze biti modifikovana tako da izmijeni statistiku klastera. Spektralni potpisi
(grupisani kasnije u klase) su sracunati iz regionalnih srednjih vrijednosti poznatih podrucja i

njihovih kovarijacionih matrica [4].
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Slika 5- Primjer interaktivne identifikacije poznatog podrucja sa i.class modulom (LANDSAT-
TM7 RGB

Interaktivna selekcija obu€enih podru¢ja: Manualna vektorizacija obucenih podrucja se
moze dobiti i pomocu i. class. Prvo, satelitski bendovi treba da budu smjeSteni u grupu i1
podgrupu slika koris¢enjem i.group. Za pocetak modul i.class definiSe grupu i podgrupu slike.
Tako, obezbjeduje naziv za “’rezultate sprektralnih potpisa’’. Naime sadrzi spektralne potpise za
posljednju procesiranu klasifikaciju. Opciono je wuclitavanje prethodno nekad odradenih
spektralnih potpisa. Nakon toga specificiramo raster za prikaz. Ovaj raster nece biti ukljucen za
prikaz statistike, ukoliko nije prethodno ukljucen u grupu slika.

Kao rezultat dobijamo podrucje monitora podijeljeno na 3 dijela. U gornjem desnom uglu
je prikazana slika. U donjem desnom je prikaz uveéanog dijela mape, dok u lijevom dijelu je

prikaz histograma za selektovano obucavajuccée podrucje za sve bendove.



4.3 Multitemporalna analiza

Dostupnost multitemporalnih snimaka daljinske detekcije koji su prikupljani duzi
vremenski period je od velikog znacaja za pracenje stanja Zivotne sredine. Napredne analize
podrzavaju monitoring Zemljine povrSine i atmosfere u razli¢itim porstornim i vremenskim
skalama. Mnoge od tih metoda su opisane u obimnoj literaturi daljinske detekcije. Ovdje ¢emo
se fokusirati na jednostavne vremenske serije analiziraju¢i ih sa MODIS (Moderate resolution
Imaging Spectroradiometar) senzorom koji je postavljen na Terra i Aqua NASA satelit. Terra je
lansiran u decembru 1999. godine, a Aqua u maju 2002.godine. Podaci analizirani su Land
Surface Temperature (LST — rezolucija piksela nominalno 1km?). Da bi pojednostavili upotrebu
ovih podataka originalno dostavljenih u HDF formatu i sinusoidalnoj projekciji, prostorni
dijelovi Sjeverne Karoline su kreirani koris¢enjem MODIS mapa. Ovi podaci su dostupni u
odvojeni MAPSET modis20021st. Vremenska serija u MAPSET modis20021st ukljucuje dvije
dnevne mape od septembra 2002., dok su jul i avgust nekompletni. Dakle, ¢etiri mape dnevno su
dostupne od prvog septembra u MAPSET.

Poredani su na sljede¢i nacin:
e Aquau01:30 (npr. aqua lst night20020921),
e Terrau 10:30 (npr. terra_Ist day20020921),
e Aquau 13:30 (npr. aqua_Ist day20020921)
e terrau 22:30 (npr. aqua_Ist day20020921).
Kao prvo, dodajemo modis20021st MAPSET u putanju mape, te listu dostupnih mapa:
g.mapsets add=modis20021st
g list rast map=modis2002lst

# night overpass at 22:30h, temperatures in degree Celsius
d.rast.leg terra_Ist night20020921

d.vect us_natlas_hydrogp type=boundary col=blue

d.vect us_natlas_urban type=boundary

d.vect us_natlas_urban disp=attr attrcol=NAME type=centroid \
where="AREA>=0.002" Isize=12

# day overpass at 10:30h

d.rast.leg terra_Ist day20020922

d.vect us_natlas_hydrogp type=boundary col=blue

d.vect us_natlas_urban type=boundary

d.vect us_natlas_urban disp=attr attrcol=NAME type=centroid \
where="AREA>=0.002" Icol=black lsize=12

MozZemo lako izraCunati vrijednosti piksela izmedu kasno vecernjih i ranih jutarnjih LST

koriS¢enjem r.mapcals:



# difference night LST to next morning

r.mapcalc "diff day night=terra Ist day20020922 -\

terra_lst night20020921"

d.rast.leg diff day night

d.vect us_natlas_hydrogp type=boundary col=black

d.vect us_natlas_urban type=boundary col=brown

d.vect us_natlas_urban disp=attr attrcol=NAME type=centroid \
where="AREA>=0.002" Icol=black lsize=12

Neiznenadujuce, jezera se karakteriSu sa stabilnom temperaturom, dok vece razlike postoje za
urbana podrugja.

Mozemo koristiiti ove podatke da generiSemo razli¢ite vremenske serije indikatora. Ono §to
moze da stvori probleme u ovom sluc¢aju su oblaci.

U sljede¢em primjeru, raunamo dnevni LST prosjek za septembar 2002. godine. U cilju da
minimizujemo nepotrebne korake, piSemo jednostavni UNIX skript.:

# bash shell script style

fordin ‘seq 1 30°; do

DAY="‘echo $d | awk ’ {printf "%02d\n", $1} "
LIST="g.mlist type=rast pat="*Ist*200209$ {DAY }" sep=",""

g wr ¥ {lg _t:,:‘,,- P’ R e " Rt : b
. e T __;_- 7 o
i * 4 A
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Slika 6- LST mapa dobijena preko MODIS-a: a)Prosje¢na temperatura zemljista za septembar
2002. godine (u stepenima Celzijusima) pokazuje vrela urbana podrucja i relativno hladna jezera,
b) razlika izmedu dnevne i no¢ne LST na odredeni dan, c¢) dnevna LST, d) no¢na LST koris¢ena

za racunanje razlika

Iako na odredenom broju mjesta nije bilo dovoljno podataka zbog oblaka, rezultati
filtriranih LST mapa jasno pokazuju visoku temperaturu u urbanim podruc¢jima u septembru
2002. godine. Relativne razlike se mogu vidjeti izmedu pojedinih jezera, ali konstatacija je da su

jezera i uza podrucja oko njih znatno hladnija od ostatka (urbanog podrucja).



5. Uputstvo za prakticni dio

5.1 Uvod

Unsupervised klasifikacija ili klasifikacija bez nadzora je jedna od dvije najCesée
kori$¢enje “’tradicionalne’” metode za klasifikaciju. Cesto su unsupervised i supervised

klasifikacija koriS¢ene u kombinaciji.

5.2 Definisanje nove GRASS lokacije

Da bi GRASS zapoceo projekat, mora biti prvo povezan na bazu (Database) koja se naziva
1 GISDBase ili GIS Data Directory. Ta baza je obi¢no folder sa podfolderima na racunaru.
Nakon povezivanja na bazu potrebno je pristupiti lokaciji (LOCATION). LOCATION
direktorijum pohranjuje koordinatne sisteme ili projekcije koje ce MAPSETS koristiti. MAPSET
je “’dijete’’ direktorijuma LOCATION 1 sadrzi geografske podatke u sebi. Postoje dva tipa
MAPSET-ova: permanentni 1 vlasnicki.

Nakon pokretanja GRASS GIS-a dobijamo prozor u kome je potrebno da postavimo GIS
Data Directory i unutar njega da kreiramo grassdata folder i selektujemo ga kao bazu podataka.

Sljede¢i korak je definisanje lokacije. Klikom na Location wizard se otvara prozor u kome
biramo jedan od ponudenih nacina za definisanje lokacije i unosimo traZzene podatke za podrucje
koje je predstavljeno na snimcima koje zelimo obradivati ( Slika 8-9).

Podaci koris¢eni za unsupervised klasifikaciju se odnose na podrucje Beograda. Na slici

ispod je dat prikaz koji se dobije komadom Settings-> Region->Dispay region (Slika7).



(Sat Jun 13 18:14:3& 2015)
g.region -p

projection: 1 (UTM)

Zone: 34

datum: wgsg4
ellipsoid: wgsg84

north: 4962780

south: 4361836

west: 453174

east: 455084

nsres: 2

eWres: 2

rowWs: 472

cols: 855

cells: 450760

(Sat Jun 13 18:14:37 2015) Command finished (0 sec)

Slika 7-Podaci o uéitanom snimku
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Slika 8- Prozor u kome kreiramo LOCATION
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(©) Specify projection and datum terms using custom PROJ.4 parameters
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Slika 9- Opcije za georeferenciranje snimaka

5.3 GRASS graficki korisnicki interfejs i koncepti

Kada se GRASS GUI pokrene vidimo sva odvojena prozora: Layer Manager i the Map
Display.
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Slika 10- Prozori dobijeni pokretanjem GRASS GIS-a

Layer Manager se satoji od:
e Menu Bar — omogucuje pristup svim GRASS funkcijama;
e Toolbars — omogucuje konvencionalni pristup najcesce korisS¢enim GRASS funkcijama;
e Four Tabs
o Map layers - upravljaju pregldom lejera mapa;
o Command console — prikazuju izlazne segmente pokrenutih komandi;
o Search module — obezbjeduje hijerarhijski listing svih GRASS funkcija;
o Python shell — obezbjeduje pristup Python interpreteru za slanje komandi.

5.4 UnosSenje i grupisanje slika, podeSavanje za Region

Importovanje rasterskih fajlova koje ¢emo koristiti za unsepervised klasifikaciju vr§imo
preko File > Import Raster Data > Common formats import [r.in.gdal]. U novootvorenom
prozoru podesavamo polja : Source Type, Source settings (Format, File), List of GDAL layers.

Nakon toga idemo na Import i Close dugme. U konzoli je prikazan rezultat funkcije
importovanja.

VaZzno je napomenuti da GRASS importuje bend za bendom, po jedan raster za svaki bend.

GRASS tretira svaki bend kao odvojeni raster file. Svaki od bendova moze biti prikazan posebno

(Slika 11).
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Slika 11- Prikaz prvog benda koris¢enog snimka



5.5 Unsupervised klasifikacija — prakticni dio

Za izvodenje klasifikacije snimka, bendovi moraju biti kombinovani u grupe i podgrupe. Grupa
je kolekcija raster mapa. Podgrupa je podset grupe rastera mapa. U ovom slucaju su kreirane
grupe gl 1 podgrl sa odredenim bendovima sadrzanim u sebi. Sljede¢i korak je pokretanje
klasifikacije. Spektralne potpise moZemo pokrenuti na dva nadina. Prvi bi bio preko
Imagery-> Classify image—> Clustering input for unsupervised classification, a drugi preko
unosa teksta i.cluster u komandoj konzoli. U kartici Required podesimo prethodno kreirane
grupe, podgrupe, dodijelimo naziv za spektralne potpise, a u kartici Settings unesemo zeljeni
broj klasa i minimalni broj piksela u klasi, procenat konvergencije, maksimalni broj iteracija te
pokrenemo Run (Slika 12). Nakon §to je zavrSeno kreiranje potpisa, prelazimo na drugi korak
unsupervised klasifikacije. Pokrecemo Imagery—>Classify Image—>Maximum likelihood
classification (MLC) ili unoSenjem i.maxlik u komandnu konzolu. Dobijamo prozor u kome

unosimo podatke za naziv novodobijenog fajla, grupu, podgrupu i naziv prethodno kreiranih

spektralnih potpisa (Slika 13).
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N to generate an unsupervised image classification.
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Slika 12- Kreiranje spektralnih potpisa

L o 5700 g Doy emien e N ]

Slika 13- IzvrSenje klasifikacije

Dobijeni rezultat klasifikacije izgleda kao na slici ispod:
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Slika 14- Rezultat klasifikacije



Koris¢enjem komande File > Map Swipe poredimo rezultat klasifikacije i pocetni
snimak kako bismo odredili koja boja na klasifikovanom snimku predstavlja koju povrSinu na

originalnom snimku (Slika 15).
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Slika 15- Map Swipe naredba

5.6 Uputstvo za supervised klasifikaciju

Supervised klasifikacija je drugi naj¢esce koriS¢eni ‘’tradicionalni’’ metod za klasifikaciju
snimaka. Cesto je ovaj emtod kori$¢en zajedno sa unsupervised klasifikacijom kako bi se dobila
hibridna slika klasifikacije 1 kategorizacija piksela po na¢inu upotrebe i vrsti pokrivaca.

Primarna razlika izmedu supervised i unsupervised metode je da supervised metoda
zahtijeva fajl sa spektralnim potpisima (Cesto se nazivaju i "obucenim podru¢jima" ili
"obu€avajué¢im potpisima").

Postupak kreiranja nove lokacije je isti ako za unsupervised klasifikaciju (vidi poglavlje
5.2), kao 1 postupak importovanja snimaka ( vidi poglavlje 5.4). Pored ovoga potrebno je kreirati
grupu 1 podgrupu, tako da mozemo koristiti postupak iz prethodno objaSnjene unsupervised
klasifikacije.

Sada kada je snimak ucitan i grupe i podgrupe definisane zadnji korak je da se podesi
region. Region je podgrupa od Location definisane pravouglim boksom. Region je vazan za
rastere 1 operacije nad slikama kao njihova granica podrucja koja ¢e biti procesirana u GRASS-u.

Podesavanje regiona se vrsi preko sljede¢e komande: Settings->Region > Set region ili
kucanjem rijeci region u komandnoj konzoli. Nakon Zeljenih podeSavanja pokrenemo Run i

ukoliko nema nekih greSaka idemo na Close.



I kona¢no nakon ovih podeSavanja, prelazimo na samu supervised klasifikaciju.

Prvi korak je kao $to je ve¢ naglaseno kreiranje obucavajuceg podrucja, pa kreiramo novu
vektor mapu. Tu mapu konvertujemo u raster mapu koja ¢e biti karta za prelazak na supervised
klasifikaciju.

Komandom Vector->Develop vector map ->Create new vector map kreiramo novu
vektor mapu. Popunimo trazena polja i idemo na OK. Desnim klkom na novu vektor mapu
biramo Show attribute data i dobijamo otvoren GRASS GIS Attribute Table Manager prozor
koji dozvoljava prikaz, upite 1 modifikaciju atributa vektor mape. Klikom na tab Manage tables
dobijamo mogucnost kreiranja, uklanjanja i izmjene naziva kolona atributa. Kreiramo novu

kolonu preko Add column sekcije i damo joj odredene karakteristike kao na slici ispod

(Slikal6).
Add column
Column | Desar Type |varchar v Length | 10 = Add

Slika 16- Kreiranje nove kolone atributa

Sada kada smo kreirali vektor mapu treba da prikazemo raster mapu koju Zelimo

klasifikovati. Umjesto kreiranja raster kompozita, mi ¢emo kreirati novi RGB raster.

U Layer Manager-u klikom na ‘Add various raster map layers’ dugme |_|11 selektujemo
‘Add RGB map layer’. Nakon toga se otvara d.rgb alat gdje podesimo zahtijevane parametre

(stavljamo RGB snimke). Klikom na OK se kreira RGB raster i dodaje na listu lejera (Slika 17).
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Slika 17- RGB raster u Map Display i Map Layers List

Naredni korak je kreiranje obucavaju¢ih podrucja. Kreiraéemo 5 obucavaju¢ih podrucja
(poljoprivredno zemljiSte, voda, trava, Suma i1 urbano podrucje). Editovanje po¢injemo desnim
klikom u map layer listi i odabirom ‘Start editing’. Ovo ¢e nam obuguditi prikaz toolbar-a u

Map Display prozoru (Slika 18).
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Slika 18- Digitizer Toolbar u Map Display prozoru



Zumiramo na Zeljeno podrucje, u ovom slu€aju poljoprivredno zemljiSte (Slika 19) 1 kliknemo

na ‘Digitize new area’ % . Ovaj alat izvodi akcije lijevim klikom, undo akcije sa kontrolnim
klikom 1 potvrdi/zavrsi akcije sa desnim klikom. Da bismo kreirali podrucje sa 4 tacke,
kliknu¢emo 5 puta. Peti klik je na pocetnu tacku kako bi se zatvorio poligon i desni klik kako bi
se kompletiralo podrucje (Slika 20).

Slika 19- Poljoprivredno zemljiste Slika 20 — Selektovana polj. povrSina

U ’Define attributes’ dijalogu postavimo ‘Descr’ vrijednost atributa na npr. ‘AG1’ i klik na
’Submit ’ kako bismo sacuvali atribute.
Na isti nacin kreiramo obucavajuéa podrucja za ostale klase (Slika 21-24).

Slika 23 — Suma Slika 24 — Urbano podrucje



Ukoliko se napravi greska u iscrtavanju koristi se ‘Delete feature(s)’ tool ‘FLIB za brisanje
nezeljenih oblika. Za koriséenje ovog alata prvo kliknemo lijevim klikom na outline objekta,

zatim desni klik da potvrdivanje brisanja. Nakon zavrSetka iscrtavanja 5 obucavajuéih podrucja

klik na ‘Quit digitizer’ dugme {1} nakon ¢ega kazemo ‘Yes’ da saCuvamo promjene.

Idu¢i korak je konverzija u raster mapu preko komande Vector->Map type
conversions—>Vector to raster (v.to.rast) nakon ¢ega se otvara prozor u kome popunjavamo
trazene parametre. Klik na dugme ‘Run’ za izvrSenje konverzije. Obucavajuéa podrucja ¢e biti

otvorena u Map Display (Slika 25).
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Slika 25- Obucavauca podrucja prikazana u Map Display

Raster mapa obucavaju¢ih podrucja prikazuje NULL celije kao bijelo podrucje. Sljedeéim
naredbama ¢emo uciniti transparentnim NULL ¢celije da bismo vidjeli kako izgledaju
obucavajucéa podrucja na originalnom snimku:

e Desni klik na obuc¢avajuca podrucja i odabir polja Properties

e Klinna ‘Null cells’ tab
e Obiljezi ‘Overlay (non-null values only) i OK na kraju.
Sada su NULL éelije transparentne i oba rastera su prikazana kao na slici ispod (Slika 26).

Slika 26- Obucavajuci skupovi sa transparentnim NULL ¢elijama

Sada prelazimo na drugi korak supervised klasifikacije. U ovom koraku, prvo generiSemo
spektralne potpise obucavajucih podrucja dok se finalni odnosi na kona¢no izvrSenje supervised

klasifikacije. Postupak je sljedeci:



e Klik na Imagery—> Classify image—> Input for supervised MLC (i.gensig) na Layer
Manager prozoru;

e Unsemo zahtijevana podrucja: obucavajuéu mapu, naziv grupe, podgrupe te naziv
izlaznog fajla.

e Klik na ‘Run’ dugme za izvrSenje operacije. Ukoliko sve prode bez gresSaka zatvorimo

i.gensig dijalog.

Na sljedecoj slici je prikazan fajl sa spektralnim potpisima.

#AG1

553

17.2387 61.9132 44.1266 207.203 89.8192 39.748¢
1.30886

0.538872 1.39825

0.879151 1.09978 2.91511

-0.84191 0.128119 -6.4351 114.749

0.936358 1.51145 1.72945 7.89357 4.83681
1.00938 1.37669 2.51195 -7.56675 2.52149 4.3733

Slika 27- Fajl sa spektralnim potpisima za poljoprivredno zemljiste

Prva linija na slici ukazuje na labelu klase, u ovom slucaju ‘AGIl’ S§to reprezentuje
poljoprivredno zemljiSte. Druga linija ukazuje na broj Celija u klasi. Treca linijea je srednja
vriednost po bendu klase. Ostale linije su polumatrice kovarijanse bendova.

Za importovanje cijelog seta obucavajucih podrucja koristimo sljedec¢u naredbu: File—>Import
Vector Data> Common formats import [v.in.ogr| gdej podeSavamo trazeno i importujemo

lejere 1 idemo na ‘Run’ nakon ¢ega dobijemo prikaz kao na slici 28.

Slika 28- Kompletan set obucavajucih podrucja



Sljedeci koraci su:

e klik na Imagery—>Classify image—> Input for supervised MLC (i.gensig) gdje popunimo
zahtijevane tabove;
e potvrdivanje operacije na dugme ‘Run’;
e klik na Imagery—> Classify Image—>Maximum likelihood classification (MLC) [i.maxlik] i
unosimo trazena polja te potvrdujemo dugmetom ‘Run’.
Konacéni rezultat klasifikacije je dat na slici ispod (Slika 29). [7]

Slika 29- Vizualizacija supervised klasifikacije



6. Zakljucak

Osnovni zadatak ovog seminarskog rada je bio da pokaze samo jednu od mnogobrojnih
oblasti primjene GRASS GIS softvera otvorenog koda. Kroz rad su objaSnjena dva osnovna
metoda klasifikacije, sa nadgledanjem i bez nadgledanja. Takode objasnjena je istorija razvoja
GRASS GIS softvera, kao i moguénost rada sa rasterskim i vektorskim podacima. Klasifikacija
snimaka dobijenih daljinskom detekcijom je kao Sto je reCeno samo jedna u nizu moguéih
operacija koje mogu da se izvrse..

Klasifikacija snimaka dobijenih tehnikama daljinske detekcije (najcesce aero 1 satelitskim
snimanjima) se koristi u odredivanju pokrivaca i nacina koriStenja zemljista u cilju pripreme
podataka za unos u geografske informacione sisteme, pra¢enju urbanog razvoja, procjeni rizika
od poplava, nadgledanju usjeva i1 Suma itd. U nekim od primjena rezultat klasifikacije je zeljeni
proizvod (npr. odredivanje pokrivaca i nacina koriStenja zemljiSta), dok je u drugim samo jedan
korak na putu do dobijanja zeljenog proizvoda.

Sto se ti¢e poredenja unsupervised i supervised klasifikacije sami znamo iz svega ovoga
gore predocenog da unsupervised klasifikacija radi sama bez nadzora ¢ovjeka. To zapravo ima
svoje prednosti 1 mane. Prvo ¢emo krenuti sa prednostima unsupervised klasifikacije. Naime,
unsupervised klasifikacija je korisna za evaluaciju podru¢ja gdje imamo malo ili nikakvo
predznanje. Moze biti koriStena kao inicijalni alat za dobijanje neke predforme za supervised
klasifikaciju. Za razliku od supervised klasifikacije koja =zahtijeva ru¢no obiljezavanje
obucavajuc¢ih podrucja, unsupervised klasifikacija je nepristrasna u svojoj procjeni piksela. Na
drugu stranu, nedostatak informacija o podruc¢ju koje obradujemo moze jako da oteza neophodni
algoritam. Bez predznanja korisnik moze da eksperimentiSe sa brojem spektralnih klastera.
Svaka iteracija produzava vrijeme izvrSenja te moze da izazove tesku interpretaciju finalnog
fajla. Unsupervised klasifikacija nije osjetljiva na kovarijacije 1 varijacije u spektralnim

potpisima objekata. Algoritam moze pogresno odvojiti piksele sa malo drugacijim spektralnim



vrijednostima i dodijeliti ih nekoj drugoj jedinstvenoj klasi [11]. Prednosti obje metode
klasifikacije leze u lakoé¢i sa kojom program obavlja statistiCke analize. Nakon zavrSetka
klasifikovanja moguce je navesti tacan broj piksela u svakoj reprezentativnoj klasi.

Prednosti supervised klasifikacije se ogledaju u generisanju klasa, ru¢nom odredivanju
obucavajuc¢ih podrucja te u tome $to su obucavajuca podrucja ponovo upotrebljiva. Nedostaci
ove klasifikacije su varijacija homogenosti potpisa klasa, dugotrajno i tesko obiljezavanje

obucavajuéih podrucja i sli¢no [12].
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